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ABSTRACT

Flex Track Drilling systems are being used increasingly
in aerospace applications providing low cost, highly
efficient automated drilling systems. Certain applications
like circumferential splice drilling on large size airplane
fuselages require multi spindle flex track systems
working in tandem to meet production efficiency
requirements. This paper discusses the development of
a multi spindle flex track driling system for a
circumferential splice drilling on the 777 airplane.

The multi spindle system developed uses a variety of
flex track carriages attached to the flexible vacuum
tracks to allow for offset or wide inside drilling.
Segmented machine programmes allow these multiple
machines to be deployed on the same circumferential
splice on the airplane providing the multi spindle system.
Interfacing of the multiple spindles is achieved by a
custom OEM interface using a single screen thereby
ensuring simplicity of operation. A central database
location ensures that all programmes are current and
maintains operational status of all holes being drilled.
Tool life monitoring is also provided to ensure consistent
tool changeovers for maintaining hole quality and
process capability. Flexible track lengths can be spliced
together for long lengths and shortened for clearance or
areas using smaller programmes. This paper also
discusses the development of the carriage hardware
specific to the 777 airplane requirements using the
methodology of adapting existing flex track system
designs as well as point design specific to the 777
Fuselage Circumferential Splice Drilling Application.
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INTRODUCTION

In the fall of 2007, a Boeing internal cross-functional
team was chartered to investigate implementation of
automation technologies to mitigate the challenges that
have increased with higher production rates in 777
fuselage assembly. A technical report published by this
team proposed the application of selective automation to
the 777 Fuselage Integration processes. By
implementing selective automation the benefits of
reduced repetitive injuries, reduction of skin quality
defects and lower cycle time in some of the fuselage
integration processes would be realized. An additional
benefit would also be the resultant consistent/repeatable
and reliable process. These improvements would drive a
better work environment, which would reflect on better
attendance, less attrition and a higher employee morale.
This Technology implementation would result in an
improved product to the customer.

After a detailed investigation of current build processes
of longitudinal and circumferential splices it was
determined that the focus should be on automation of
the drilling of the circumferential splice on the 777-300
airplane, Aft fuselage section. To reduce developmental
cost it was determined to use as much as possible off-
the-shelf technologies with minimal developments
needed to adapt to the 777 airplane requirements. Also
taken into consideration was that the equipment chosen
would need to be adaptable with few or no changes to
current Floor Assembly Jig (FAJ) or floor mounted
equipment (FME).

SELECTIVE AUTOMATION PROPOSAL

A technical evaluation of the longitudinal and
circumferential splice drilling and fastening processes



revealed that application of automation to selected
portions of these processes would provide the greatest
benefit for the investment incurred. On circumferential
splice drilling and fastening processes it was discovered
that the drilling processes constituted almost 70% of the
total process time. These drilling processes included
pilot drilling of holes, full size drilling of holes as well as
countersinking processes. Any implementation of
automation on these drilling processes would yield major
gains in productivity including additional benefits of
improved ergonomics, improved skin quality and overall
an improvement of the production process and overall
product quality.

The study of the automation of the fastening processes
for the circumferential splices yielded that gains realized
by automation would not result in great improvements in
productivity for these processes. Some of the gains
would be offset by the additional process monitoring time
as required by engineering specifications for the
automated fastening processes. By focusing on the
drilling processes only of the circumferential splices, the
automation equipment requirements were also greatly
simplified due to the omission of additional fastener
insertion end effectors, clamp up equipment etc. This
allowed the team to evaluate more options for the
automated drilling equipment as many suppliers met the
specifications for the drilling equipment but not for the
drilling/fastening equipment, making it easier to obtain
off the shelf automated drilling equipment. A time study
along with an ergonomic study, combined with
production process data including quality charts was
compiled to help arrive at a decision for development
and implementation of selective automation in 777
Fuselage Integration.

CURRENT PROCESS

The current baseline process for drilling and fastening of
the circumferential splices is a complete manual
process. This process starts with location of the splice
plates, shear ties and at the end stringer splices as
shown in Figure 1 and Figure 2. Circumferential splice
plates are currently located for station and buttock line
by hand, using drawing references. Then shear ties and
stringer splices are then located with multiple locating
jigs (LJ's). All parts are secured with undersize
temporary fasteners. At this point in the process all
holes are drilled undersized from existing pilot in parts
through skin. Depending on size and parts stack-up
holes are drilled in step-up process to final size by hand
or power feed equipment.

Figure 1. 777 — Buttsplice Components (splice plates,
shear ties, stringer splices)

Figure 2. 777 — Buttsplice Components (Detail)

Currently the set-up, part locating, drilling and
countersinking process of aft fuselage circumferential
join takes roughly 100 man hours. Hand drilling and
countersinking of more than 3,000 holes poses several
challenges including, fastener locations and types must
be identified prior to drilling to  mitigate
drilling/countersinking of incorrect fastener hole sizes
and countersinking types. Simultaneous operations are
hindered by FME equipment (flip doors scaffolding and
ladders) requiring multiple shift operations. Hole and
countersink sizes and stack-ups require multiple cutter
changes. In some areas large stack ups of more .750
inches requires power feed drilling operations which also
requires mounting of drill jigs (DJ's). Chip recovery
during drilling/countersinking operations is also an issue
with the current process.

PROPOSED PROCESS



EQUIPMENT SELECTION

Various off the shelf technologies were evaluated by the
cross-functional team for the automation of the
circumferential splice drilling processes. These included
robotic drilling, overhead gantry (5 axis) drilling, track
based portable drilling systems such as Mini-Flex Track
and finally track based machine drilling systems such as
Flex Track Drilling Equipment. All technologies were
evaluated for technical feasibility of use for the
circumferential splice drilling processes. The Flex Track
Machine based system provided the most feasible
solution for an off the shelf based machine as it required
the least amount of modifications to meet the 777
Fuselage integration requirements. Other advantages
offered were ability to cover drilling of holes on wider
footprint adjacent to the circumferential splice. This
offered the ability to drill more holes using the
automation equipment than originally envisioned.
Another benefit was that Flex Track Technology
originally developed by Boeing offered a familiarity
advantage over other technologies giving it a higher
probability of success during implementation. At the end
the Flex Track Machine offered the best right size, most
efficient & simple and the least modified off the shelf
solution for the selective automation programme.

TECHNICAL DEVELOPMENT

Drilling circumferential splices and frames is difficult to
automate due to the inherently large machine needed to
traverse the great expanse of the fuselage accurately.
Existing airplane fuselage assembly jigs were not
designed to accept large pieces of automation for drilling
these splices. However the Flex Track attaches directly
to the fuselage and uses the massive parts it’s drilling as
the primary machine base. Although initially designed
for fuselage drilling the standard Flex Track was too
short and narrow to be well suited for the splice drilling,
and individually too slow.

Flex Track technology is well suited for fuselage drilling
as lightweight flexible tracks splice together indefinitely
and small local transformations eliminate the need for
‘global’ accuracy [1]. Track designs use compressed air
and hundreds of venturi pumps to generate vacuum.
The single set-up needed for 777 is long at over 50 feet,
generating more than 35 tons of suction from almost 500
vacuum cups. One problem was how to supply air to the
starving venturi's, another was that such a long
assembly of track acts like a wet noodle, and where is it
stored? Finished hole patterns over a meter in width
forced an entirely new Flex Track design, an Extremely
Wide Flex Track or EFT.

By using the Fanuc PowerMate CNC the Flex Track
control easily handles the synchronous drives and the
total of seven axis needed for an EFT. Previous Flex
Track Designs have five servo axis’, X,Y,Z, servo

spindle, a extra rotation axis A [2], the EFT needs
another two. First an EFT needs another X-axis, let's
call X, to accurately position the Flex Track. Without X’
even the lightweight head becomes a problem as it
travels far away from a single drive axis vacuum rail
causing large moments on the single drive rail resulting
in a twist and walking of  the rail.

Figure 2, New C-Axis Capability 1

The track design has always been to float one side [2].
The CNC will now tie them together with a new axis of
rotation, the C-axis. Closed loop feedback and
elimination of track side loads allows EFT to travel
accurately along the long tracks. The C-axis is
measured using a 1 million count rotary encoder to keep
the Cartesian relationship with the primary drive track by
driving X'.

Production schedules inherently demand certain tasks
take set amount of time. All located now the details
have hundreds of backed drilled holes for the automation
to find. Automation can reduce time with faster drills and
faster drives, but nothing moves faster than adding
another machine or two operating on the same machine
bed running the same program. Multiple EFT’s are still
small enough they arent much of a technical
development as an obvious advantage. For this
application three EFT’s will be used, allowing three
automated spindles to be used simultaneously.

777 ADAPTATIONS

In the production environment a Gantry Handling System
or GHS, is used to quickly retrieve, store, and deploy
multiple EFT’s. The GHS solves the flexible rail problem
too, by accurately holding the 10 sections of pre-spliced
rails. Now the vast majority of the handling is merely
lifted or lowered with a touch of a button and rolled
away. A custom control was integrated into the GHS
and three synchronous lifts are used to lift the EFT’s
from the fuselage without damaging the rails. A single
maintenance mode allows for a retrieval of any EFT from
anywhere on the fuselage.



Once the EFT’s are deployed the GHS is rolled away
and stored. Lastly, four more sections of rail are spliced
at each end of the 10 track sections loaded from the
GHS.

The new track design needed to incorporate the dual
drive, allowing for the new C-axis, allow for more air flow
to the venturi’s, and also be easy to splice. Also the
current cup design needed to change to accommodate
the airplane’s clad surface. Some of these design
requirements are solved with a taller cup design. The
taller cups allow more room for air lines, splice plates,
and help avoid brackets and back drilled details on the
fuselage skin. This is very helpful on such a long track,
as an easy splice makes adding and removing track
quick. The dual track set-up is over 50 inches wide and
clears every obstruction around the splice keeping the
EFT out of the way of other work in the cell.

Previous track designs were developed close to the
airplane, but increasing the track height off the skin will
simplify most of the design problems. The other obvious
impact of the increased height is the need to flatten part
data to the new track offset. Using a custom pre-
processor, the EFT can get flattened machine pattern
data developed inside Catia [1],[2], developed at any
reasonable distance off the surface being drilled. The
flattened machine pattern data programs are developed
with relationships based on any two features.

Separating part programs allow for multiple spindles
operating on the same track to be working on small
discreet programs. Many details are located and
fastened in the fuselage join. Some details are loosely
located with respect to each other in specific non critical
directions while primarily being accurately located in
other directions. An EFT needs to reference off features
to be able to put an accurate pattern of holes relative to
the back drilled holes. A custom GUI shows the part
program in relation to the EFT. This same interface ties
in with a database for tool and process data, and saves
individual progress for each job as completed. A
standard feature on the EFT is the laser edge finder
using simple macros find holes and verify part to track
orientation. Relationships between all the located holes
are available to be easily re-acquired by locating a

primary and secondary hole. After being drilled a holes
status is updated and drill tool life is incremented for fast
recovery into a program status. If an EFT is not
available to finish the program it started, another EFT
can acquire the program and finish.

PROPOSED IMPLEMENTATION PLAN

The implementation plan for the multi-spindle flex track
drilling system on the 777 circumferential splice drilling
process involves a 2 phase approach comprising of
testing (laboratory & factory) and a phased in
implementation schedule. The various stages of the plan
include:

1) Testing at Electroimpact with drilling coupons.

2) Testing at Boeing laboratories with drilling coupons.
3) Equipment qualification testing for Design & Quality
engineering requirements

4) Development of the process monitoring programme
5) Testing of proposed process for parts indexing with
ink marking (no drilling) in the factory

6) Testing of proposed process in the factory with parts
indexing with drilling of holes

7) Full scale implementation in drilling process in the
factory



7.0 Acronyms

EFT: Extremely Wide Flex Track

GHS: Gantry Handling System

CNC: Computer Numeric Control

GUI:  Graphical User Interface

X,Y,Z,AX,C  Axis Names

8.0 References

[1] Elex Track Drill, Buttrick, SAE 2003-01-2995, 2003
[2] Elex Track for use in Production, Thompson,
Hartmann, Buttrick, Feikert. SAE 2005-01-3318, 2005

CONCLUSION
Here is the conclusion paragraph.
ACKNOWLEDGMENTS

Here is the Acknowledgment section. This is an optional
section.

REFERENCES

1. Inclusion of this section is mandatory.
2. Type references over these paragraphs.

CONTACT

This is where main author information is typed, if
desired, such as background, education, e-mail address,
and web address. This is an optional section.

ADDITIONAL SOURCES

Here are any additional sources. This is an optional
section.

HELPFUL HINTS:

DEFINITIONS, ACRONYMS, ABBREVIATIONS

Here is the Definitions section.
section.

Term: Definition for the term

APPENDIX

This is an optional

m Tables — when creating tables, do so by using the “Insert Table” command under the Table menu.

m  Greek Fonts — when using Greek fonts in your paper, please apply the “Symbol” style to the characters by using the

“Style” command under the Format menu.

m  Bold, Underline, Italic — when applying these styles in your paper, please apply the appropriate style to the character

by using the “Style” command under the Format menu.

m Figures — please number figures consecutively.

m Insert column breaks or page breaks (Insert / Break on menu bar) to maintain better control of text flow.



